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tered trademarks of Apple Computers, 
Inc. Windows is a registered trademark of 
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user guide are trademarks or registered 
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Copyright
• Program copyright ©1998 RAYflect 

SA.
• RAYflect PhotoTracer™ User Manual 

©1998 RAYflect SA. 

No part of this guide may be repro-
duced in any form or by any means with-
out the prior written permission of 
RAYflect SA.

Notice
Before using this software or reading 

this user guide, make sure you have read, 
understood and agreed to the license 

contained at the end of the RAYflect 
PhotoTracer™ User Guide.

Credits
RAYflect PhotoTracer™ was created by:

• Olivier Bienvenu, Brice Figureau and 
Pierre Terdiman

• Objects designed by: Pierre Bretag-
nolle and Antoine Clappier

User Interface Design:
• Antoine Clappier

The RAYflect PhotoTracer™ user guide 
was created by Antoine Clappier, assisted 
by Clare Thirlway.



Table of Contents iii

Bump Mapping. . . . . . . . . . . . . . . . .13
4
hts 

5
7
0
2
4

7
8
8
8
9
9
9
9

3
3
4
4
5
6
6
7

Rotate Object . . . . . . . . . . . . . . . . . 37
Resize Object  . . . . . . . . . . . . . . . . . 38

Scene Modes . . . . . . . . . . . . . . . . . . . 38
Edit 2D Mode. . . . . . . . . . . . . . . . . 39
Edit 3D Mode. . . . . . . . . . . . . . . . . 39
Alternate Ghost Menu. . . . . . . . . . . 39
Dolly Camera Tool . . . . . . . . . . . . . 39
Pan Camera Tool  . . . . . . . . . . . . . . 40
Zoom Camera Tool. . . . . . . . . . . . . 40
Focal Camera Tool  . . . . . . . . . . . . . 41

Arranging Objects
Undo/Redo  . . . . . . . . . . . . . . . . . . . 42
Clipboard Management . . . . . . . . . . . 43
Delete a selection  . . . . . . . . . . . . . . . 43
Duplication . . . . . . . . . . . . . . . . . . . . 43
Managing Selections  . . . . . . . . . . . . . 43
Group/Ungroup . . . . . . . . . . . . . . . . 44

 Shading Objects
 Assigning Shaders to objects . . . . . . . 45
The Shader Preview . . . . . . . . . . . . . . 45
Shader Channels  . . . . . . . . . . . . . . . . 46

Color Channel. . . . . . . . . . . . . . . . . 46
Highlight Channel  . . . . . . . . . . . . . 48
Bump Channel  . . . . . . . . . . . . . . . . 49
Reflection Channel  . . . . . . . . . . . . . 51
Transparency Channel . . . . . . . . . . . 52

 Interactive Texture Renderer  . . . . . . 53
How does it work?  . . . . . . . . . . . . . 53
Assigning textures to objects . . . . . . 53
RAYflect PhotoTracer™ User Manual ©1998 RAYflect SA

TABLE OF CONTENTS

Trademarks

Table of Contents

Welcome
Introduction  . . . . . . . . . . . . . . . . . . . . 1
System Requirements . . . . . . . . . . . . . . 1

Windows 95 / 98 / Windows NT . . . 1
MacOS. . . . . . . . . . . . . . . . . . . . . . . . 1

Installation . . . . . . . . . . . . . . . . . . . . . . 1
Windows 95 / 98 / Windows NT . . . 1
MacOS. . . . . . . . . . . . . . . . . . . . . . . . 1

Removing Extensions . . . . . . . . . . . . . . 1
Windows 95 / 98 / Windows NT . . . 1
MacOS. . . . . . . . . . . . . . . . . . . . . . . . 2

Getting Technical Support . . . . . . . . . . 2

Tutorials
Welcome  . . . . . . . . . . . . . . . . . . . . . . . 3
 Manipulating a single object  . . . . . . . . 3

Launching RAYflect PhotoTracer . . . . 3
Loading a simple 3D object  . . . . . . . . 4
Editing a 3D object  . . . . . . . . . . . . . . 5
Shading 3D object . . . . . . . . . . . . . . . 7
Rendering  . . . . . . . . . . . . . . . . . . . . . 9

Lesson 2: Texture mapping and camera 10
Using the Edit 3D Mode . . . . . . . . . 10
Texture Mapping . . . . . . . . . . . . . . . 11

Saving your work  . . . . . . . . . . . . . . .1
Lesson 3: Reflection, transparency and lig
15

Setting up Lights  . . . . . . . . . . . . . . .1
Reflection and transparency. . . . . . . .1

 Lesson 4: Building a scene . . . . . . . . .2
 Lesson 5: Layer and layer effects  . . . .2
 Lesson 6: Cartoon rendering  . . . . . . .2

Interface Tour
Generalities . . . . . . . . . . . . . . . . . . . . .2
File and Edit menu . . . . . . . . . . . . . . .2

File Menu . . . . . . . . . . . . . . . . . . . . .2
Edit Menu  . . . . . . . . . . . . . . . . . . . .2

Scene Working Window and Modes  . .2
Shader Editor . . . . . . . . . . . . . . . . . . .2
Light Editor . . . . . . . . . . . . . . . . . . . .2
Rendering Section  . . . . . . . . . . . . . . .2

Loading, Saving Objects

Objects manipulation and viewing
Working Window . . . . . . . . . . . . . . . .3

Preview Modes . . . . . . . . . . . . . . . . .3
Image Settings  . . . . . . . . . . . . . . . . .3
Render Test  . . . . . . . . . . . . . . . . . . .3
 Ghost Menu (tm)  . . . . . . . . . . . . . .3

Objects Manipulation . . . . . . . . . . . . .3
Object Selection . . . . . . . . . . . . . . . .3
Move Object. . . . . . . . . . . . . . . . . . .3



Table of Contents iv

Modifying lighting scheme . . . . . . . . 54 /Objects/Web/Torus Buttons/ . . . . .74

6
6
6
6
7
7
7
7
8

8
8
8
9
9
9
0
0
0

RAYflect PhotoTracer™ User Manual ©1998 RAYflect SA

Modifying the Environment . . . . . . . 54
Limitations. . . . . . . . . . . . . . . . . . . . 54

Lighting
 Ambient Light  . . . . . . . . . . . . . . . . . 55
Light set-up . . . . . . . . . . . . . . . . . . . . 56

Light source State. . . . . . . . . . . . . . . 56
Light Source Color. . . . . . . . . . . . . . 56
Light Source Position . . . . . . . . . . . . 57

Rendering
Environment Map  . . . . . . . . . . . . . . . 58
Renderer Settings . . . . . . . . . . . . . . . . 60
Rendering a scene  . . . . . . . . . . . . . . . 61

Object Catalogue
Introduction  . . . . . . . . . . . . . . . . . . . 63
Installation . . . . . . . . . . . . . . . . . . . . . 63

Windows 95 / 98 / Windows NT . . 63
MacOS. . . . . . . . . . . . . . . . . . . . . . . 63

Getting Technical Support . . . . . . . . . 64
/Objects/Fruits/ . . . . . . . . . . . . . . . . 65
/Objects/Fun/ . . . . . . . . . . . . . . . . . 66
/Objects/Miscellaneous/  . . . . . . . . . 67
/Objects/Packaging/  . . . . . . . . . . . . 68
/Objects/Primitives/ . . . . . . . . . . . . . 69
/Objects/Web/ . . . . . . . . . . . . . . . . . 70
/Objects/Web/Rectangle Buttons/  . 71
/Objects/Web/Round Buttons/ . . . . 72
/Objects/Web/Square Buttons/ . . . . 73

End-User License Agreement
Important notice . . . . . . . . . . . . . . . . .7
1. Definition . . . . . . . . . . . . . . . . . . . .7
2. Grant of license . . . . . . . . . . . . . . . .7
3. Copyright . . . . . . . . . . . . . . . . . . . .7
4. Product maintenance  . . . . . . . . . . .7
5. Disclaimer of warranty  . . . . . . . . . .7
6. Governing law  . . . . . . . . . . . . . . . .7
7. Termination  . . . . . . . . . . . . . . . . . .7
8. Entire agreement  . . . . . . . . . . . . . .7

Licence d’Utilisation de Logiciel
Important . . . . . . . . . . . . . . . . . . . . . .7
1. Définition . . . . . . . . . . . . . . . . . . . .7
2. licence  . . . . . . . . . . . . . . . . . . . . . .7
3. Propriété intellectuelle  . . . . . . . . . .7
4. Maintenance . . . . . . . . . . . . . . . . . .7
5. Exclusion de garantie  . . . . . . . . . . .7
6. Droit applicable  . . . . . . . . . . . . . . .8
7. Résiliation . . . . . . . . . . . . . . . . . . . .8
8. Intégralité, modification  . . . . . . . . .8



Welcome
Introduction

1

nts

o 

er-

ion

AY-

To install RAYflect PhotoTracer:
1 Unzip the archive

2 Run the installer

3 Follow the on-screen instructions to 
install RAYflect PhotoTracer.

MacOS
First download the archive on the RAY-

flect Web site.

To install RAYflect PhotoTracer:
1 Unstuff the archive

2 Copy the "PhotoTracer" folder to the 
’Plugins/Filters" folder located in 
your Photoshop folder

Removing Extensions

Windows 95 / 98 / Windows NT
To remove RAYflect PhotoTracer, sim-

ply run the installer. 
RAYflect PhotoTracer™ User Manual ©1998 RAYflect SA

WELCOME

Introduction
Thank you for purchasing RAYflect 

PhotoTracer
This Photoshop extension gives you all 

the tools and effects needed to create 
amazing 3D scenes inside Photoshop. 
RAYflect PhotoTracer includes all the 
features found in thousands dollar worth 
3D software: transparency, reflection, 
refraction, bump mapping, multiple light 
sources and much more. RAYflect Pho-
toTracer come with more than 230 origi-
nal objects specially designed for CD-
ROM content, packaging, web page 
design...

No matter you want to create a simple 
sphere or a complicated scene, Pho-
toTracer is the fastest and simplest way to 
do it. With RAYflect PhotoTracer, we 
reduced the complexity, not the quality.

System Requireme

Windows 95 / 98 / Windows NT
• Pentium, Pentium II, Pentium Pr

based PC
• Windows 95, 98, Windows NT S

vice Pack 3 or later
• Color Display, at least 16-bit
•  Application that 100% supports 

Adobe Photoshop 3.0.5 filter

MacOS
• PowerPC based Macintosh
• MacOS System 7.5 or later
• Color Display, at least 16-bit
•  Application that 100% supports 

Adobe Photoshop 3.0.5 filter

Installat

Windows 95 / 98 / Windows NT
First download the archive on the R

flect Web site.
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MacOS
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To remove RAYflect PhotoTracer, sim-
ply drag the "PhotoTracer" folder in the 
trashcan.

The "PhotoTracer" folder is in the 
’Plugins/Filters" folder located in your 
Photoshop folder.

Getting Technical Support
For Technical Support or for more 

information about RAYflect's products, 
see our World Wide Web site on the 
internet:

http://www.rayflect.com

http://www.rayflect.com
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TUTORIALS

Welcome
Welcome to the RAYflect PhotoTracer 

tutorial. This tutorial is designed to intro-
duce you to all the major features and 
functions in RAYflect PhotoTracer. The 
main goal of the tutorial is to teach you 
the techniques you need to know to cre-
ate 3D illustrations.

Each section is self-contained so you 
can start the tutorial at any point. But we 
advise the beginner to start from lesson 1.

The tutorial uses various files which can 
be downloaded from the RAYflect site in 
the RAYflect PhotoTracer download sec-
tion:

http://www.rayflect.com

 Manipulating a single obj

Launching RAYflect PhotoTracer
The first thing to do is to start Pho

shop, create a new document then ru
RAYflect PhotoTracer.

Note: In the tutorial we use Photoshop 5
as a host application. But the tutorial 
be used with other versions of Photoshop
other hosts such as Painter, Photo-Pain
etc.

To run RAYflect PhotoTracer:
1 Launch Photoshop.

2 Create a new RGB document. 

3 Choose Filter>RAYflect>Pho-
toTracer

4 Click cancel button to return to P
toshop

http://www.rayflect.com
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Loading a simple 3D object
In the following lesson we will use a 

small 300 by 300 pixels document.

To start the lesson:
1 Launch Photoshop.

2 Create a new 300 by 300 pixels RGB 
document. 

3 Choose Filter>RAYflect>Pho-
toTracer

The first step is to load a 3D Object in 
the RAYflect PhotoTracer 3D Work-
space. This 3D Workspace is where all 
objects are displayed, assembled, and 
manipulated. 

To load an object: 
1 Click with the left mouse button on 

File> button

2 Choose Open item

3 With the file requester, select Tutori-
als/Lesson1/Tore.ptc
RAYflect PhotoTracer™ User Manual ©1998 RAYflect SA
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Workspace in Gouraud Mode

Editing a 3D object
Let's see how you can move, rotate and 

resize a 3D object. To move the torus 
simply click and drag. 

To move an object:
1 Click on the object to select it

2 Click and drag to move the object

To rotate the torus select it, then right 
click (ctrl click on Macintosh) and select 
Rotate on the “Ghost Menu(tm)”. The 
RAYflect PhotoTracer™ User Manual ©1998 RAYflect SA

File and edit menu

A blue torus is now visible in the middle 
of the Workspace. It is displayed using 
the default quality: wireframe. To get a 
more realistic preview of the 3D objects, 

RAYflect PhotoTracer offers different 
rendering quality modes:
• Bounding Box mode (Objects are 

drawn as boxes).

Bounding Box Mode Button

• Wireframe mode (Only edges of 
objects are drawn). 

Wireframe Mode Button

• Flat shaded mode (Faces of the 
objects are drawn flat, with highlights) 

• Gouraud shaded mode (Faces are
drawn smoothed, with highlights)

Gouraud Mode Button

• Textured mode (Transparency and
textures are displayed) 

Textured Mode Button

To change the preview quality
1 Simply click on one of the Previe

Quality radio buttons

To get a smooth preview, now choo
Gouraud Shaded mode. Your Worksp
should look like this:
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Ghost Menu(tm) is the best way to 2 Select the Rotate Objects tool or 

ori-

only 

th 
tm) 

To Scale a selection:
1 Make sure the object is selected.

2 Select the Scale Tool in the toolbar or 
the Scale item in the Ghost Menu(tm)

3 Drag the mouse horizontally to 
change the object size

Scale Tool

Ghost Menu Scale Tools

To Scale a selection on only one local axis:
1 Make sure the object is selected.

2 Select the X,Y or Z button near Scale 
in the Ghost Menu(tm).

3 Drag the mouse horizontally.

To get used to the Ghost Menu(tm), 
move, scale and rotate the torus several 
RAYflect PhotoTracer™ User Manual ©1998 RAYflect SA

manipulate RAYflect PhotoTracer’s 
objects. The Ghost Menu(tm) is a new 
generation of user interface; every com-
monly-used command is accessible 
directly from the Working Window, in 
only one mouse click.

Ghost Menu

We advise you to get used to launching 
commands from the Ghost Menu(tm). 
Doing this will dramatically reduce your 
design time. But if you prefer, you can 
also use the Object command icons 
located to the left of the window. 

To Rotate an object or a selection with the 
virtual trackball:
1 Make sure the object is selected.

Rotate from the Ghost Menu(tm)

3 Click and drag to rotate to a new 
entation

Rotate Tool

Ghost Menu Rotate Tool

To Rotate an object or a selection around 
one axis:
1 Make sure the object is selected.

2 Select the X,Y or Z button near 
Rotate in the Ghost Menu(tm).

3 Drag the mouse horizontally.

To scale your torus do exactly as wi
the rotation, display the Ghost Menu(
but this time choose the Scale item.
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times. If the torus gets too distorted, you 

ke 

Rotated and scaled torus

Shading 3D object
We have seen how to modify the geom-

etry of the objects. Let’s see now how we 
can edit their shading.

Shaders are used in order to apply sur-
face properties to objects. The Shader 
determines whether the object is shiny or 
dull, rough or smooth, transparent or 
opaque, etc. By combining different sur-
face properties you can completely 
change how an object looks.
RAYflect PhotoTracer™ User Manual ©1998 RAYflect SA

can go back to its previous state using the 
multiple Undo and Redo commands. 
There are 32 levels of undo.

To Undo the last object manipulation:
1 Go to Edit Menu.

2 Select Undo.

or

3 Hit Control/Command Z.

To Redo the last undone object manipulation
1 Go to Edit Menu.

2 Select Redo.

or

3 Hit Control/Command Y.

Edit Menu

Your Workspace should now look li
this:
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clicking on the color swatch (do not for-
get to select the torus before doing this).

To change highlight color:
1 Click on the Highlight Color 

swatch.

2 A pop-up color window appears con-
taining a color spectrum.

3 Release the mouse button when the 
mouse cursor is on the color you 
want.

To specify numerically highlight color
1 Click on the Color Swatch while 

holding the Ctrl-Key down.

2 The standard color picker should 
appear.

3 Select or enter the color you want and 
hit the OK button.

Modify the Shininess and watch the 
result in the Workspace.

To change the shininess
RAYflect PhotoTracer™ User Manual ©1998 RAYflect SA

of our torus. Below the Workspace you 
will find the Shader Palette. Click on the 
Color Tab.

Shader Palette

Since you are going to modify the sur-
face of your object, you should adjust the 
Preview Quality to Gouraud Shaded 
mode. 

To specify a color as Color Channel:
1 Select the Use Color radio button.

2 Click on the Color Swatch.

3 A pop-up color window appears con-
taining a color spectrum.

4 Release the mouse button when the 
mouse cursor is on the color you 
want.

To numerically specify a color as Color Ch
nel:
1 Select the Use Color radio butto

2 Click on the Color Swatch while
holding the Ctrl-Key down.

3 The standard color picker should 
appear.

4 Select or enter the color you want
select OK.

Apply a purple color to the torus. T
torus is now purple but still lacks a sh
and realistic surface. In the real world
objects show highlights when they ar
illuminated. These bright spots are re
tions of light sources onto the materi

Plastic surfaces show dimmed and l
highlights, unlike metallic objects wh
highlights are small and bright; other
materials like stone or concrete do no
produce highlights.

Click on the Highlight Tab and 
change the highlight color to white b
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1 Select an object Rendering
irst 
 go 
ati-

 ren-
 
 

and SAT antialiasing. But all you want 
to know is that this new RAYflect render-
ing engine delivers a high quality image in 
a short space of time!

Wait a few seconds, your purple torus 
now appears in your document. Zoom on 
the image to see the subtle light interac-
tions and high quality antialiasing on the 
edges of the torus.
RAYflect PhotoTracer™ User Manual ©1998 RAYflect SA

2 Drag the thumb of the Shininess 
Slider.

To get a flashy purple plastic object set 
shininess to 5. The Torus should now 
look like this:

Purple Torus with highlights

Use the Ghost Menu to rotate the torus 
several times. As you can see, the torus 
now reflects the light in a much more 
realistic way.

You are now ready to render your f
3D object in Photoshop. Click OK to
back to Photoshop, the torus is autom
cally rendered in the document.

To render 3D objects, RAYflect Pho-
toTracer uses one of the most advanced
dering technologies: Hybrid ScanLine
RayTracing engine with oversampling
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• Set camera Focal

Camera Tools

To start with, you are going to rotate 
the camera around the cube. To do this 
use the Dolly tool. The Dolly tool is used 
to rotate the camera around the view-
point. It acts exactly as if you were using a 
virtual trackball.

To use the Dolly:
1 Select the Dolly tool from the Camera 

Toolbar OR select Dolly from the 
Ghost Menu(tm).

2 At this stage, the mouse cursor will 
reflect the tool used.

3 Click in the Working Window and 
drag the mouse pointer to rotate the 
view.
RAYflect PhotoTracer™ User Manual ©1998 RAYflect SA

Lesson 2: Texture mapping
and camera

To start this lesson:
1  Create a new 400 by 300 pixels RGB 

document in Photoshop.

2  Launch RAYflect PhotoTracer.

3  Open Cube.ptc, located in Tutori-
als/Lesson2/. 

Using the Edit 3D Mode
Now that you know how to manipulate 

3D Objects in a 2D Workspace, let’s 
jump into full 3D! To do this click on the 
Edit 3D Tab at the top of the work-
space.

Edit 3D Tab

In Edit 3D Mode, you see your 3D 
scene as through the viewfinder of a real 
camera. The cube is now displayed using 

live cube. Your Workspace should loo
like this:

Lesson 2 Workspace

The Edit 3D mode lets you manipu
the camera and the objects in the 3D
world.

In Edit 3D mode a new toolbar 
appears, labeled Camera, containing 
tools:
• Zoom
• Pan
• Dolly
• Roll
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Texture Mapping
RAYflect PhotoTracer allows you to put 

a 2D image on the surface of your 
objects: texture mapping. This 2D 
image can be a scanned photograph or 
paint-type illustration created in Photo-
shop. Used effectively, texture maps can 
lend your shaders an unparalleled realism. 
Many complex objects are nearly impossi-
ble to simulate through other means.

RAYflect PhotoTracer lets you load 
either a JPEG file or BMP file.

To use an image as Color Channel:
1 Select the Use Texture radio button.

If no texture was loaded, a standard file 
selector is displayed, letting you choose 
the image file you want.

To change the texture used as Color Channel
1 Click on the little Disk Icon.

or
RAYflect PhotoTracer™ User Manual ©1998 RAYflect SA

Dolly Tool

Ghost Menu Dolly Tool

We advise you to use the Ghost 
Menu(tm) (see Lesson 1). You will go 
much faster selecting the commands in 
the Ghost Menu(tm) than switching back 
and forth between the different Camera 
and Object tools.

Using the Ghost Menu, you can also 
Zoom, Pan, Roll and set camera Focal. 
Try these different commands. If you lose 
the cube, use the Alternate Ghost Menu 
to reset the camera.

By holding the Alt/Option key while 
activating the Ghost Menu(tm), you have 
access to the Alternate Ghost Menu(tm). 
The Alternate Ghost Menu lets you 
change the point of view of your viewing 
camera. 

The Alternate Ghost Menu lets yo
change the point of view of your cam
• Ref: Reference camera (perspectiv

view)
• Left/Right: Left and Right views
• Top/Bottom: Top and Bottom v
• Last: returns to the last perspectiv

view.

Alternate Ghost Menu

To reset the camera:
1 Hold Alt key and right click (Ctrl c

on Macintosh).

2 Select Ref item
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1 Activate the local menu (right mouse  
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then switch to the Textured mode as specific 
details (like texture) become important.

You can rotate, tile and flip the texture, 
see Color Channel for more information.

The Textured mode just shows you a 
preview of the textured objects. In RAY-
flect PhotoTracer you do not have to hit 
the OK button to render then switch 
back to PhotoTracer to modify some-
thing...You can render your scene directly 
within the RAYflect PhotoTracer’s Work-
ing Window, with the best final quality.

To render the image with the final qual-
ity:

Click on the Render Image Button

Render Image Button

While the image is rendering, you can 
abort the rendering by hitting the ESC 
key (or the Command-. (dot) key combi-
nation on Mac).
RAYflect PhotoTracer™ User Manual ©1998 RAYflect SA

button click on Windows/ Com-
mand-Click on Macintosh) and 
choose Load.

A standard file selector should appear, 
letting you choose the image file you 
want to load.

Once the file is loaded, the texture 
swatch should display a preview of your 
image.

Both the objects sharing this shader and 
the Shader Preview should change 
accordingly.

Disk Icon

Select your cube, click on the disk icon 
in the Color Palette, open DiceMap.jpg 
in Tutorials/Lesson2/. Now your cube 
has a dice texture map. 

To see the texture use the Textured 
mode:

Textured Mode Button

Your Workspace should look like th

Workspace in Textured Mode

Note: Textured mode and Gouraud-sha
mode show details of the shape and colo
your objects, but take longer to calculat
and draw. To increase RAYflect Pho-
toTracer efficiency, you might want to w
in Wireframe at the outset of a project
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Bump Channel

If no bump map is loaded, the bump 
map swatch should display a light checker 
pattern; otherwise you can see a preview 
of your image.

RAYflect PhotoTracer lets you load 
either a JPEG file or BMP file.

To change the bump map:
1 Click on the little Disk Icon near the 

bump map swatch.
or

1 Activate the local menu (right mouse 
button click on Windows/ Com-
mand-Click on Macintosh), and 
choose Load.

A standard file selector should arise, let-
ting you choose the image file you want 
to load.
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Your Workspace should look like this:

Rendered Cube

Bump Mapping
Rough surfaces are extremely difficult 

to model and lead to complex objects. 
Imagine the irregularities of an orange 
skin: it would be impossible to geometri-
cally model each irregularity by hand.

RAYflect PhotoTracer simulates the 
variations on the surface of an object in a 
really efficient way with the Bump Chan-
nel.

nel, you can disturb a smooth surface
add irregularities.

Note: Bump Channel does not modify 
surface of the geometric objects but rat
changes the angle of incidence of the lig
at certain points of the surface, thus pr
ing a ’bumpy’ effect. As this is a trick o
RAYflect PhotoTracer, the edges of the 
objects remain smooth.

To simulate bumps, the texture use
the Bump Channel (also called bump
map) must specify a variation betwee
adjacent pixels. This means that if you
image is filled with a plain color, it w
not produce any bumping. As color in
mation in the image is not used by R
flect PhotoTracer (what is important
the relative changes between adjacen
pixels) it is often better to use graysca
pictures as bump maps.
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Once the file is loaded, the bump map 

sity 

er 
nge 

ck 
1.3.
to 

is:

Saving your work
Using the Ghost Menu(tm), zoom, 

dolly the camera until you get a good 
view of your dice. When you are done, 
you can save your scene using the File 
Menu. If later you want to use the dice 
again, you will just have to reload the file 
created during this lesson.

To save your scene in a new file:
1 Click with the left mouse button on 

the Edit button.

2 Choose Save As.
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swatch should display a preview of your 
picture.

Both the objects sharing this shader and 
the Shader Preview should change 
accordingly.

Disk Icon

Select your cube, click on the disk icon 
in the Bump palette, open DiceBump-
Map.jpg in Tutorials/Lesson2/. 

Click on the Render Image Button to 
see the result.

In order to achieve subtle effects when 
modifying a surface, RAYflect Pho-
toTracer provides you with a slider to 
change the intensity of the Bump effect.

This slider, whose range is -3 to +3, lets 
you increase the bump effect (high val-
ues), soften the bump effect (low values), 
and even inverse the bump effect (nega-
tive values).

To change the bump intensity:
1 Drag the thumb of the bump inten

slider.

2 Both the objects sharing this shad
and the Shader Preview should cha
accordingly.

Bump Intensity Slider

To create little holes around the bla
dots of the dice, set the intensity to: -

Click on the Render Image Button 
see the result.

Your Workspace should look like th
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3 When the standard save dialog box 

ns-
hts

GB 

l 

4 Open Dollar.ptc, located in Tutori-
als/Lesson3/. 

Setting up Lights
The final appearance of your scene 

depends greatly on how you light it. A 
good lighting scheme (lights’ positions 
and colors) can dramatically increase the 
readability and the atmosphere of a ren-
dered scene. Like in real world photogra-
phy, it is very important to take time to 
set up the light. 

RAYflect PhotoTracer lets you adjust 
up to six infinite directional light sources, 
and one ambient light.

Note: Infinite directional light sources are 
outside the RAYflect PhotoTracer 3D 
Workspace (thus their emitting points are 
not visible) and cast parallel light rays in 
the 3D Workspace. 

All the light controls can be found in 
the Light Sources palette.
RAYflect PhotoTracer™ User Manual ©1998 RAYflect SA

shows up, enter the file name.

4 Click Save.

Save your scene as Dice.PTC in the 
Tutorials/Lesson2 folder.

Click OK to render the dice.

Even if you don’t save your scene, each 
time you hit the OK button the scene is 
automatically saved in the Current File. 
So, next time you launch RAYflect Pho-
toTracer you will find your latest scene. 
The Current File is also used to rerender 
a scene without launching the RAYflect 
PhotoTracer interface. If the selection has 
changed, RAYflect PhotoTracer will 
resize your scene accordingly.

In Photoshop create a selection using 
the Rectangular Marquee Tool and hit 
ctrl F or Command F to rerender the 
dice.

Rendered cubes

Lesson 3: Reflection, tra
parency and lig

To start this lesson
1 Create a new 400 by 300 pixels R

document in Photoshop.

2 Fill the background with a neutra
dark gray (R=64, G=64, B=64)

3 Launch RAYflect PhotoTracer.
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sources in RAYflect PhotoTracer is as 

hed 

n 

hed 

4 The lighting of the scene viewed in 
the Working Window should be 
updated accordingly.

Bulb Light Icon OFF

Now click on the color swatch below 
the first Light Bulb Icon and choose a 
bright color. Try with another color and 
watch the result in the 3D Workspace. To 
finish, set the first light source color to 
white.

To Change the color of a light source:
1 Click on the Light Color Swatch.

2 A pop-up color window appears con-
taining a color spectrum.

3 Release the mouse button when the 
mouse cursor is on the color you 
want.

Light Color Swatch
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Light Sources Palette

Lighting effects will become visible in 
the Working Window when RAYflect 
PhotoTracer is configured on Flat shaded 
preview and above. In the lesson use the 
Gouraud shaded mode.

) 

Gouraud Mode Button

The Dollar.ptc file has only one light 
source turned on. Turn it off by clicking 
on the Bulb Light Icon: your object is 
black. Turn it on again to see the differ-
ence. As you can see, manipulating light 

simple as real light sources.

To turn off a light source:
1 Make sure the light you want to 

switch off is actually enabled.

2 Click on the Light Bulb Icon.

3 The icon should change to a switc
off light bulb.

4 The lighting of the scene viewed i
the Working Window should be 
updated accordingly.

Bulb Light Icon OFF

To turn on a light source:
1 Make sure the light you want to 

switch on is actually disabled.

2 Click on the light bulb icon.

3 The icon should change to a switc
on light bulb.
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Turn on the second light source: 

r 
h.

low 

 of 
ght 

n 

Try turning the different light sources 
on and off, changing their color and posi-
tion to get the following 3D Workspace:

Workspace

To get exactly the same light scheme, 
open the file Dollar2.ptc in the Tutori-
als/Lesson3/ folder.

Reflection and transparency
Click on the Render Image Button to 

see the result. Your object looks like a 
dull metal object. Let’s add some reflec-
tions!
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orange highlights appear on the borders 
of the objects. To edit the position of the 
light source click and drag the virtual 
sphere in the Light Source Palette. 

To set the position of the light, imagine 
the light sphere as a glass ball surround-
ing your scene. The highlight shows 
where the light shines through the glass, 
toward the center of your scene.

As you can only see one hemisphere of 
the virtual light sphere at a time, there is a 
special control which is used to inverse 
the light position. By default when this 
control shows an arrow from top to bot-
tom, the light source is above the scene, 
and when the arrow is in the opposite 
direction, the light source is under the 
scene.

As there are six light sources and only 
one virtual light sphere, each light has a 
selector item graphically represented as a 
yellow dot. If the yellow dot is under the 
fourth light source for instance, it means 
that the light sphere will actually show 
the position of the fourth light.

To select the light source to be edited:
1 Click on the light source selecto

under the light source color swatc

2 The light source selected has a yel
spot as light source selector.

Light Source Selector

To set the position of a light:
1 Drag the highlight on the surface

the light sphere to position the li
source.

2 The lighting of the scene viewed i
the Working Window should be 
updated accordingly.

Light Sphere
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One of the key feature of RAYflect Pho- Tab in the Shader Palette and set the 

 set 

tch.

on-

he 

s:

Interactive Texture Mode

A default Environment is used: it is a bi-
gradient, simulating a sky and a ground. 
The Environment is a great way to 
improve objects’ reflections.

Imagine that the Environment map is 
projected onto the inside of a big sphere 
surrounding your scene. Any reflected 
objects will reflect this map.

The Environment is really useful when 
your scene contains highly reflective 
objects (like chrome, or metal objects). 
Rendering reflective objects without a 
good Environment map will give dull 
effects on objects (since there is nothing 
RAYflect PhotoTracer™ User Manual ©1998 RAYflect SA

toTracer is that it can handle true reflec-
tions and transparency in real time. To 
edit reflection and transparency, click on 
the Interactive Texture Tab located at the 
top of the 3D Workspace. The Interactive 
Texture Renderer renders the current 
scene with the final quality, storing some 
useful information needed to perform the 
shading in real time.

To activate the Interactive Texture Renderer:
1 Simply click on the Tab labeled ’Inter-

active Texture’

2 Click on the black image in the center 
of the window

3 Wait a few seconds as the image is 
rendered

4 An image of your scene rendered with 
the final quality should appear

Click on the object to edit its shader.

To get a realistic mirror-like object, first 
turn its color to black. Click on the Color 

color to black.

Now click on the Reflection Tab and
the color to a light gray: the object 
reflects its surroundings.

Reflection channel

To change reflection color:
1 Click on the reflection color swa

2 A pop-up color window appears c
taining a color spectrum.

3 Release the mouse button when t
mouse cursor is on the color you 
want.

The Workspace should look like thi
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to reflect). Chrome and metal effects are Load the Environm.jpg image located 
 the 
ks 

c-
e 
. 

u 
e 
tte. 

Transparency Channel

To change transparency color:
1 Click on the reflection color swatch.

2 A pop-up color window appears con-
taining a color spectrum.

3 Release the mouse button when the 
mouse cursor is on the color you 
want.

To finish this lesson, load the 
Dollar3.ptc file located in the Tutori-
als/Lesson3/ folder.

Click OK to render.
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best achieved with a good Environment 
map, for instance a landscape image.

RAYflect PhotoTracer lets you select an 
image as the Environment, and lets you 
rotate, flip and tile it.

To change the Environment map:
1 Click on the little disk icon near the 

Environment map swatch.

2 A standard file selector should appear, 
letting you choose the image file you 
want to load.

3 Once the file is loaded, the Environ-
ment map swatch should display a 
preview of your picture.

Environment Map

in Tutorials/Lesson3/ folder. Now
object looks much more realistic than
to this new environment.

To get a warmer effect, set the refle
tion color light to orange/yellow. Th
dollar letter seems to be made of gold
The Workspace should look like this:

Interactive Texture Mode

In the Interactive Texture mode yo
can also see transparency. Click on th
Transparency tab in the Shader Pale
Set the color to a 50% gray.
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 Lesson 4: Building a scene

To start this lesson
1 Create a new 400 by 300 pixels RGB 

document in Photoshop.

2 Fill the background with a neutral 
dark gray (R=64, G=64, B=64)

3 Launch RAYflect PhotoTracer.

4 Open Button.ptc, located in the 
Tutorials/Lesson4/ folder. 

In the lesson use the Gouraud shaded 
mode.)

Gouraud Mode Button

A scene is made up of several 3D 
objects. To insert a new object in a scene 
use the Insert Item in the File Menu.

To Insert objects into a previously created 
scene:
RAYflect PhotoTracer™ User Manual ©1998 RAYflect SA
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1 Click with the left mouse button on 

o-
, 
 the 

 

 in 

You can also Copy, Cut and Paste using 
the Edit Menu.

Duplicate W again then drag to the 
right.

Your 3D Workspace should look like 
this:

When manipulating multiple objects, it 
is easier to manipulate only one entity. So 
it is possible to group several objects, and 
manipulate them exactly as if they were 
only one object.
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the Edit button.

2 Choose Insert.

3 Select in the drop-down list the file 
format you want to open.

4 Browse your hard-disks, and select a 
file (either a .PTC file or a .3DS file).

5 Select Open.

Insert the W.ptc file located in the 
Tutorials/Lesson4/ folder.

Your 3D Workspace should look like 
this:

We are going to create the www acr
nym. Select the letter W. To duplicate
hit ctrl d or command d, then drag to
left.

To duplicate a selection:
1 Select any objects

2 Choose Edit Menu -> Duplicate
(Ctrl/Command-d)

3 The objects are duplicated and are
the same location as the originals.
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Grouped objects have blue bounding 
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4  Open Mars.ptc, located in the Tuto-
rials/Lesson5/ folder. 

Click OK to render.

RAYflect PhotoTracer renders the fly-
ing saucer in the transparent layer. The 
antialiasing (border of the object) is done 
using levels of transparency, so the 3D 
object’s borders always blend perfectly 
with the background. If you wish you can 
change the background and you will not 
have to render again the 3D objects in 
the transparent layer.

You can also move the flying saucers 
around: the borders still blend with the 
background.

If you have Photoshop 5, you can use 
the Layer Effects to add special effects to 
your objects.

Select Layer>Effect>Outer Glow 
enter the following settings:
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boxes while selected, unlike ’stand-alone’ 
objects whose bounding boxes are white.

To group a selection:
1 Choose Edit Menu -> Group (Ctrl/

Command-g).

2 The objects forming the selection are 
grouped together.

Shift select the three letters then select 
Group in the Edit Menu or hit ctrl g or 
command g. Now the three letters www 
can be moved, scaled or rotated. 

Reduce the size of the grouped object, 
drag it to the top of the button.

Hit OK to render.

 Lesson 5: Layer and la
effe

One of the most interesting feature
RAYflect PhotoTracer is that you are
working in Photoshop! When an imag
rendered in other 3D software, you c
not move the objects, change their co
ors, add, remove shadows, etc. RAYfl
PhotoTracer handles the alpha chann
this means you can render your 3D 
objects in multiple layers.

The antialiasing of PhotoTracer obj
are done with the alpha channel, so y
can freely move the objects around, r
or lower the layers, add shadows or gl
with Photoshop 5’s Layer Effects.

To start this lesson
1 Open in Photoshop the Back-

ground.jpg file located in the Tu
als/Lesson5/ folder.

2 Create a new layer.

3 Launch RAYflect PhotoTracer.
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Image with three layers

As you can see the combination of the 
strengths of Photoshop and RAYflect 
PhotoTracer let you create 3D illustra-
tions with an unparalleled simplicity and 
speed. No other 3D software lets you 
change the background and position of 
your objects, add or remove glow and 
shadow, etc.,  without rerendering the 
entire scene.

This is especially true when working 
with high resolution images: sometime 
rerendering an image can takes hours 
with other 3D software. With RAYflect 
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Outer Glow Settings

Your image should look like this:
Flying Saucer with glow

Create a new layer and launch Pho-
toTracer.

Select the flying saucer with the Gh
Menu, reduce its size and rotate it.

Click OK to render.

Add a green glow and move the sm
flying saucer behind the first one.

Repeat the operation to create a thi
flying saucer in a third layer.

Your image should look like this:
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PhotoTracer you can rerender a single 2 Launch RAYflect PhotoTracer. Open 
als/

ct 
h 
eese 

use 

ray 

over 

Your image should look like this:

Rendered Mouse

In Photoshop:
1  Choose Image>Select>Threshold.

2 Set Threshold Level to 230

3 Click OK.

You now have a black and white image:
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object in one of the layers and it will take 
from a few seconds to a few minutes.

When working with a large scene we 
strongly advise you to break it into multi-
ple layers and objects. This way you will 
work much faster and will have more free-
dom to express your ideas.

 Lesson 6: Cartoon rendering
This last lesson is more a tip than a 

tutorial. It will show you that by combin-
ing Photoshop features and RAYflect 
PhotoTracer, you can go off the beaten 
track of usual 3D!

To start this lesson:
1 Create a new 800 by 600 pixels RGB 

document in Photoshop. The back-
ground must be a pure white.

Mouse.ptc, located in the Tutori
Lesson6/ folder. 

3 Select the gruyère cheese (RAYfle
PhotoTracer was created by Frenc
developers so of course there is ch
in this product!).

4 Set the Color to 100% black.

5 Set the Highlight color to 100% 
white.

6 Set the Shininess to 0.

7 Drag and drop the shader on the 
other objects in the scene (the mo
and the eyes of the mouse).

To drag and drop a shader:
1 Click in the Shader Preview (the g

sphere in the Shader palette).

2 Hold the mouse button and drag 
an ungrouped object.

3 Release the mouse button.

Click OK to render.
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3 Deselect the Work Path.

e 

al-

on” 
 the 

n 

You now have a beautiful Cartoon- like 
image which would take hours to draw by 
hand!
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Black and white image

With the Magic Wand select a black 
part of the image.

Then choose Similar in Select menu.

The whole of the black area of the 
image is now selected.

Go to the Paths palette:
1 Choose Make Work Path.

2 Set Tolerance to 1.0 pixels, click OK.

Paths Palette

Clear your image (the image must b
completely white).

Select the Work Path in the Paths p
ette.

Click on the “Loads Path As Selecti
button (third button at the bottom of
palette).

Deselect path.
Hit Alt BackSpace to fill the selectio

with black.
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Cartoon Rendering



Interface Tour
Generalities

27

INTERFACE TOUR

This chapter gives you a tour of the 
RAYflect PhotoTracer User Interface. 
The RAYflect PhotoTracer window is 
subdivided into 5 parts:
• File and Edit menu
• Scene Working Window and Modes
• Shader Editor
• Light and Environment settings
• Rendering section

Generalities
Rendering is done when you hit the OK 

button. At this stage the current scene is 
stored, ready to be reopened when you 
render it again (with Ctrl/Command-F 
in Adobe Photoshop). The next time you 
launch RAYflect PhotoTracer, it will load 
the previous scene.

Clicking Cancel will discard the current 
scene.
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To activate the File Menu:
1 Click with the left mouse button on 

the File> Item

2 Choose any of the items shown

File and edit menu

Edit Menu
The Edit menu will let you interact with 

the objects in your scene, for instance 
duplicate objects.

To activate the Edit Menu:
1 Click with the left mouse button on 

the Edit> Item

2 Choose any of the items shown
RAYflect PhotoTracer™ User Manual ©1998 RAYflect SA

To quit RAYflect PhotoTracer:
1 Click on the OK Button to store and 

render the current scene.
or

2 Click on the Cancel Button to dis-
card the current scene. 

OK and Cancel buttons

At any time you can get extensive help 
through the use of tool tips on a Win-
dows computer, or Balloon Help on a 
Macintosh.

To activate extensive help:
1 Click on the Help Button located in 

the upper right corner of the RAYflect 
PhotoTracer window

Help Button

If you encounter problems while us
RAYflect PhotoTracer:

Click on the At Sign Icon (@) to di
your favorite World Wide Web brows
to our WWW site support section.

At Sign Icon

File and Edit me
These two menus let you control an

perform basic operations on your 3D
scene.

File Menu
The File Menu will let you manage

scene, for instance, load a new scene 
save the current one.
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Light Sources Palette

Rendering Section
With these settings you can adjust sev-

eral rendering options for instance the 
level of reflection or refraction.

It also allows you to specify an Environ-
ment for your scene.
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File and edit menu

Scene Working Window and
Modes

This part of the interface is used to 
arrange your objects within your scene.

It lets you see your objects through the 
Working Window, either in 2D or in 3D 
mode. 

It also lets you manipulate the objects.

Edit 2D and Edit 3D Modes

Shader Edi
The shader editor contains a Previ

and different channels. You use it to a
materials to your objects.

 

Shader Editor

Light Edi
This part of the interface deals with

light sources, and lighting schemes.
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Rendering and Environment Palette
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RAYflect PhotoTracer lets you open 
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To Insert objects into a previously created 
scene:
1 Click with the left mouse button on 

the Edit button.

2 Choose Insert.

3 Select from the drop-down list the file 
format you want to open.

4 Browse your hard-disks, and select a 
file (either a .PTC file or a .3DS file).

5 Select Open.

The new objects are added to the exist-
ing scene.

To Save your scene:
1 Click with the left mouse button on 

the Edit button.

2 Choose Save.

If your scene is being saved for the first 
time, the Save item will act in the same 
way as Save As.

If your scene has already been saved, the 
old file will be overwritten.
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LOADING, SAVING OBJECTS

As seen previously, a typical workflow 
under RAYflect PhotoTracer will begin 
by adding several objects which will make 
up your scene.

To create a new scene:
1 Click with the left mouse button on 

the File button

2 Choose Reset

3 The current scene will be cleared and 
a new one will be created

 

File Menu

two different 3D formats:
• RAYflect PhotoTracer files whose

extensions are .PTC. This is the na
RAYflect PhotoTracer format

• 3D Studio(tm) files whose extens
are .3DS

To add objects to a newly created scene:
1 Click with the left mouse button 

the Edit button.

2 Choose Open.

3 Select from the drop-down list the
format you want to open.

4 Browse your hard-disks, and selec
file (either a .PTC file or a .3DS 

5 Select Open.

6 The scene is displayed in the Work
Window.

When you open a RAYflect Pho-
toTracer file the current edited scene
lost.



Loading, Saving Objects 32
RAYflect PhotoTracer™ User Manual ©1998 RAYflect SA

To save your scene in a new file:
1 Click with the left mouse button on 

the Edit button.

2 Choose Save As.

3 When the standard save dialog box 
shows up, enter the file name.

4 Click Save.
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This Working Window contains the 3D 
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Bounding Box Mode Button

• Wireframe mode (Only edges of 
objects are drawn). 

Wireframe Mode Button

• Flat shaded mode (Faces of the 
objects are drawn flat, with highlights) 

Flat Mode Button

• Gouraud shaded mode (Faces are 
drawn smoothed, with highlights) 

Gouraud Mode Button

• Textured mode (Transparency and 
textures are displayed) 

Textured Mode Button

Textured mode and Gouraud-shaded 
mode show details of the shape and color 
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OBJECTS MANIPULATION 
AND VIEWING

The second step in the typical workflow 
will be to manipulate your objects to 
make up your scene and then select the 
best viewpoint.

Working Window
An interactive representation of the 

scene is displayed in the Working Win-
dow.

Working Window

Workspace. This 3D Workspace is wh
all objects are displayed, assembled, a
manipulated. By default RAYflect Ph
toTracer opens new scenes with only 
grid plane, called Working Plane.

This Working Plane is a visual refere
of the 3D workspace and a tool to he
you manipulate objects.

There are several tools associated w
this window:
• Preview Modes
• Picture actions
• Render test button
• Ghost Menu (tm)

Preview Modes
RAYflect PhotoTracer lets you man

late and see your scene with different
view settings.

The view has six different display 
modes:
• Bounding Box mode (Objects are

drawn as boxes).
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of your objects, but take longer to calcu- If your image is shown as a light check-
ork-
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Once the background image has been 
magnified, you can scroll the view to see 
parts of this image which are hidden.

To scroll the view of the background picture:
1 Select the Scroll Picture tool.

2 While clicking the left mouse button, 
drag the mouse pointer into the 
Working Window.

3 The background image will be 
scrolled accordingly.

Scroll Picture Tool

Render Test
While creating a scene it is always neces-

sary to render images again and again, to 
fine-tune objects’ positions or textures. 
In RAYflect PhotoTracer you do not have 
to hit the OK button to render then 
switch back to PhotoTracer to modify 
something...You can render your scene 
directly within the RAYflect Pho-
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late and draw. To increase RAYflect Pho-
toTracer efficiency, you might want to 
work in Wireframe at the outset of a 
project, then switch to the Textured 
mode as specific details (like texture) 
become important.

Image Settings
RAYflect PhotoTracer allows you to 

work inside a Photoshop layer. In order 
to place your objects relative to a back-
ground image, RAYflect PhotoTracer can 
display the current layer as a background.

To see the background image in the Working 
Window:
1 Select the Display Background 

Image toggle button.

2 Your background image should be 
visible, but dimmed in a way that 
improves the readability of your scene.

Display Background Image Button

ered image, this means that you are w
ing on a transparent layer.

You can magnify (i.e. zoom in or ou
the image, exactly as you can in Adob
Photoshop, in order to adjust the pos
tion of your objects with more precis

To zoom in the background picture:
1 Click on the Zoom In Picture bu

ton.

2 A new magnification factor is dis-
played.

To zoom out the background picture:
1 Click on the Zoom Out Picture 

ton.

2 A new magnification factor is dis-
played.

Zoom In and Out Buttons
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• You don't have to remember key-
board shortcuts.

• You have access to all the commonly-
used features of RAYflect Pho-
toTracer.

• The Ghost Menu(tm) remembers 
your last action. This means that the 
next time you activate it, the action 
you used last time is right under your 
mouse pointer. To activate it again, 
just release the mouse button.

The Ghost Menu(tm) has been orga-
nized in a way that will help you quickly 
find the commands you want:
• Left part: commands dealing with 

objects manipulation.
• Right part: commands dealing with 

cameras (the command's icon is a 
small camera).

• The color of the icon displays a fam-
ily of commands. For instance, purple 
icon commands deal with rotation: 
rotating an object (Rotate command) 
is equivalent to rotating a camera 
(Dolly command).
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best final quality.

To render the image with the final quality:
1 Click on the Render Image Button

2 While the image is rendering, you can 
abort the rendering by hitting the 
ESC key (or the Command-. (dot) 
key combination on Mac).

Render Image Button

 Ghost Menu (tm)
The Ghost Menu(tm) is the best way to 

manipulate RAYflect PhotoTracer’s 
objects. The Ghost Menu(tm) is a new 
generation of user interface; every com-
monly-used command is accessible 
directly from the Working Window, in 
only one mouse click.

We advise you to get used to launching 
commands from the Ghost Menu(tm). 
Doing this will dramatically reduce your 
design time.

Windows computer, just hold the rig
mouse button down and then move t
mouse cursor over the symbol for the
action you want to launch.

To activate it on a Macintosh compu
press the Control-Key and the mouse
button, then choose the action you w
to launch.

Ghost Menu

Once the action is activated and fin
ished, RAYflect PhotoTracer returns 
the previous toolbar action selected.

The key benefits of the Ghost 
Menu(tm) are:
• You don't have to move the mous

the toolbar (it just pops up under y
mouse).
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2 Click on an object in the Working 
Window. It is now surrounded by its 
bounding box.

Selection/Move Tool

Ghost Menu Move Tool

To add an object to the selection:
1 Choose the Selection/Move Tool in 

the Objects Toolbar, or the Move 
item in the Ghost Menu(tm)

2 Shift-click on a non-selected object 
in the Working Window to add it to 
the selection.

To remove an object from a selection:
1 Choose the Selection/Move Tool in 

the Objects Toolbar, or the Move 
item in the Ghost Menu(tm)
RAYflect PhotoTracer™ User Manual ©1998 RAYflect SA

By holding the Alt/Option key while 
activating the Ghost Menu(tm), you have 
access to the Alternate Ghost 
Menu(tm). The Alternate Ghost Menu 
lets you change the point of view of your 
viewing camera.

Alternate Ghost Menu

Objects Manipulation
In this section you will learn how to 

move, select and change your objects.
The objects tools let you perform every 

basic operation (alignment, positioning, 
orientation) by dragging in the Working 

Object Toolbar.

Object Tools

While manipulating objects you can
always undo your actions (see 8.1 Un
Redo)

Object Selection
To perform commands or actions o

objects, you need to have an active se
tion.

A selected object is surrounded by i
Bounding Box.

You can select several objects.

To select an object:
1 Choose the Selection/Move Too

the Objects Toolbar, or the Move
item in the Ghost Menu(tm)
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2 Shift-click on a previously selected 4 Move the mouse, or release the mouse 
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Selection/Move Tool

Ghost Menu Move Tool

To Move a selection perpendicular to the 
Working Plane:
1 Repeat the steps described above.

2 When moving, press the Alt/Option 
key to move perpendicular to the 
Working Plane.

Rotate Object

To Rotate a selection with the virtual track-
ball:
1 Make sure the object is selected.

2 Select the Rotate Objects tool or 
Rotate from the Ghost Menu(tm)
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object in the Working Window to 
remove it from the selection.

When arranging complex scenes, it 
often happens that you need to select an 
object which is behind another, larger 
object. RAYflect PhotoTracer lets you use 
a special feature called Selection Cycling.

To use Selection Cycling to cycle through 
overlapping objects:
1 Remove current selection by clicking 

in a region of the Working Window 
where there are no objects.

2 Click on the closest object that over-
laps the object you want to be 
selected, and hold the mouse button 
down without moving it.

3 Wait a fraction of a second, the object 
behind the first one will be selected 
for a fraction of a second. If you wait 
longer, the next object behind the one 
selected will be selected.

button when the object you want
reach is selected, to keep it selecte

If all objects have been selected in t
and if the mouse has not been moved
first object will be selected again, then
second, and so forth.

Note: RAYflect PhotoTracer does not r
on the Bounding Box of the object to pe
form selections, but rather use the real 
shapes of the objects to be more accurate

Move Object

To Move a selection parallel to the Worki
Plane:
1 Select one or more objects.

2 Select the Selection/Move tool 
either from the toolbar or from th
Ghost Menu(tm).

3 Click on an object in the Working
Window and drag the mouse, the
object will follow the mouse poin
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3 Click and drag to rotate to a new ori- Resize Object
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Ghost Menu Scale Tools

Scene Modes
RAYflect PhotoTracer implements two 

different modes of interaction with 
objects:
• Edit 2D mode.
• Edit 3D mode.

How to switch from one mode to another one:
1 Simply click on the Edit 2D or Edit 

3D Tab located in the upper part of 
the Working Window

Edit 3D Tab
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entation

Rotate Tool

Ghost Menu Rotate Tool

To Rotate a selection around only one axis:
1 Make sure the object is selected.

2 Select the X,Y or Z button near 
Rotate in the Ghost Menu(tm).

3 Drag the mouse horizontally.

Ghost Menu Rotate Tool

If the Shift Key is pressed during a rota-
tion, the rotation is constrained to an 
angle increment of 45 degrees.

To Scale a selection:
1 Make sure the object is selected.

2 Select the Scale Tool in the toolba
the Scale item in the Ghost 
Menu(tm)

3 Drag the mouse horizontally to 
change the object size

Scale Tool

Ghost Menu Scale Tools

To Scale a selection on only one local axi
1 Make sure the object is selected.

2 Select the X,Y or Z button near S
in the Ghost Menu(tm).

3 Drag the mouse horizontally.
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Edit 2D Mode
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Alternate Ghost Menu

Dolly Camera Tool
The Dolly tool is used to rotate the 

camera around the viewpoint. It acts 
exactly as if you were using a virtual track-
ball.

To use the Dolly:
1 Select the Dolly tool from the Cam-

era Toolbar OR select Dolly from the 
Ghost Menu(tm).

2 At this stage, the mouse cursor will 
reflect the tool used.

3 Click in the Working Window, and 
drag the mouse pointer to rotate the 
view.
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The Edit 2D mode is a special mode in 
which objects are seen exactly as if they 
were in 2D. This means that the interac-
tions you can have will take place in 2D 
only.

The objects are seen from a top view.
Move, Rotate, and Resize act, in this 

mode, in 2D.

Edit 3D Mode
The Edit 3D mode is a mode where 

the Working Window shows the 3D 
Workspace from a conical camera.

The Edit 3D mode lets you manipulate 
the camera and the objects in the 3D 
world.

In Edit 3D mode, a new toolbar 
appears, labeled Camera, containing four 
tools:
• Zoom
• Pan
• Dolly
• Set camera Focal

Camera Tools

You can now use the Alternate Gho
Menu.

Alternate Ghost Menu
The Alternate Ghost Menu lets yo

change the point of view of your cam
• Ref: Reference camera (perspectiv

view)
• Left/Right: Left and Right views
• Top/Bottom: Top and Bottom v
• Last: returns to the last perspectiv

view.
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Keypad 4: left
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Ghost Menu Pan Tool

You can use the Alt/Option key to 
track the camera in/out.

This command is not available in the 
Edit 2D Mode and the Preset views cho-
sen from the Alternate Ghost Menu.

Zoom Camera Tool
The Zoom command allows you to 

zoom in or out.

To use the Zoom:
1 Select the Zoom tool from the Cam-

era Toolbar OR select Zoom from the 
Ghost Menu(tm).

2 At this stage the mouse cursor will 
reflect the tool used.

3 Drag the mouse horizontally to zoom 
in or out.

Camera Zoom Tool
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Camera Dolly Tool

Ghost Menu Dolly Tool

You can use the Alt/Option key to tilt 
the camera instead of rotating it. 

You can also use the Roll item in the 
Ghost Menu(tm) to adjust the camera 
roll.

Ghost Menu Roll Tool

This command is not available in the 
Edit 2D Mode and the Preset views cho-
sen from the Alternate Ghost Menu.

The keyboard can also be used to man-
ually rotate the camera around its view-
point:

Keypad 6: right
Keypad 8: up
Keypad 2: down

Pan Camera Tool
The Pan command is used to move

camera in the 3D Workspace.

To use the Pan:
1 Select the Pan tool from the Cam

Toolbar OR select Pan from the 
Ghost Menu(tm).

2 At this stage, the mouse cursor wi
reflect the tool used.

3 Drag the mouse in the Working W
dow to pan the camera.

Camera Pan Tool
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3 Drag the mouse horizontally to 

e 
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Ghost Menu Zoom Tool

Caution: The zoom command located in 
the Camera Toolbar does not act like the 
Magnify command of the Working Win-
dow. The zoom command actually changes 
the camera, thus modifies only the view of 
the objects, unlike the Magnify command 
which modifies both the objects’ view and 
the size of the background image.

Focal Camera Tool
The focal command allows you to 

change the perspective used by the cam-
era.

To use the Set Focal:
1 Select the Set Focal tool from the 

Camera Toolbar.

2 At this stage, the mouse cursor will 
reflect the tool used.

change the focal.

Camera Focal Tool

This command is not available in th
Edit 2D Mode and the Preset views.
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Edit 

• Invert
• Group
• Ungroup

Undo/Redo

To Undo the last object manipulation:
1 Go to Edit Menu.

2 Select Undo.

or
1 Hit Control/Command Z.

To Redo the last undone object manipulation
1 Go to Edit Menu.

2 Select Undo.

or
1 Hit Control/Command Y.

You can undo/redo object manipula-
tion, such as translation, rotation, or 
object resizing. You have access to 32 lev-
els of Undo.
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ARRANGING OBJECTS

Objects are arranged in a scene through 
a hierarchy. Although the hierarchy is not 
graphically displayed, you can still modify 
it in a user-friendly way.

This hierarchy contains either objects or 
groups of objects. You can, at any time, 
group objects (and even previously 
grouped objects), and ungroup previ-
ously grouped objects.

’Stand-alone’ objects are displayed with 
white Bounding Boxes while they are 
selected, and groups are displayed with 
blue Bounding Boxes. Edit Menu

Arranging objects is done with the 
Menu which contains the following 
items:
• Undo
• Redo
• Cut
• Copy
• Paste
• Duplicate
• Select All
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Managing Selections

To Select all the objects of the scene:
1 Choose Edit Menu -> Select All 

(Ctrl/Command-A).

2 The whole scene is selected, the previ-
ous active selection is then lost.

Sometimes it may be useful to inverse 
the current active selection, for instance 
when you want to select multiple objects 
except for a few ones; simply select the 
few ones, and inverting the selection will 
do the trick.

To Invert the selection:
1 Choose Edit Menu -> Invert.

2 The objects previously selected are 
unselected, the previously unselected 
are now selected.
RAYflect PhotoTracer™ User Manual ©1998 RAYflect SA

Clipboard Management
RAYflect PhotoTracer lets you use the 

clipboard in the same way as any other 
software does.

To cut a selection in the working window:
1 Select any objects.

2 Choose Edit menu -> Cut (Ctrl/
Command-X).

3 A copy of the selection is placed in the 
Clipboard, the original is deleted.

To Copy a selection in the working window:
1 Select any objects.

2 Choose Edit menu -> Cut (Ctrl/
Command-C).

3 A copy of the selection is placed in the 
Clipboard.

To Paste a selection in the working window:
1 Choose Edit menu -> Paste (Ctrl/

Command-V).

Window.

Delete a select

To delete a selection:
1 Select the objects you want to del

2 Press the Delete Key or the Back
space Key.

Duplicat

To duplicate a selection:
1 Select any objects

2 Choose Edit Menu -> Duplicate
(Ctrl/Command-D)

3 The objects are duplicated and are
the same location as the originals.
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Group/Ungroup
When manipulating multiple objects, it 

is easier to manipulate only one entity. So 
it is possible to group several objects and 
manipulate them exactly as if they were 
only one object.

Grouped objects have blue bounding 
boxes while selected, unlike ’stand-alone’ 
objects whose bounding boxes are white.

To group a selection:
1 Choose Edit Menu -> Group (Ctrl/

Command-G).

2 The objects forming the selection are 
grouped together.

To ungroup a group:
1 Choose Edit Menu -> Ungroup 

(Ctrl/Command-U).

2 The group is split into different 
objects.
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1 Select only one object (make sure it is 
not a group).

2 Edit the shader channels.

3 The object will change accordingly.

The Shader Preview
This preview always shows the shader of 

the currently selected object or the shader 
you are editing.

The Shader Preview is automatically 
refreshed when any of the parameters of a 
shader are modified.

Shader Preview
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 SHADING OBJECTS

Shading objects is the third step in the 
creation workflow under RAYflect Pho-
toTracer.

This operation lets you texture or color 
your scene, by adding materials to your 
objects.

Shader Palette

To achieve this, use the Shader Editor, 
which is subdivided into two parts:
• Shader Preview.
• Channels making up the shaders.

 Assigning Shaders to objects
There are two ways to assign shaders to 

objects:

object.
• Select an object and modify its 

shader's channels.

To Apply a shader to an object:
1 Click on the shader preview.

2 While holding the left mouse butt
down, drag the mouse pointer to 
object.

If the object is a group, the mouse 
sor is displayed as an interdiction sign

Grouped objects have blue boundin
boxes while selected, unlike 'stand-alo
objects whose bounding boxes are w

If the object is a 'stand-alone' object
mouse cursor is an arrow. Simply dro
the shader on it, the object will now 
displayed (and rendered) with this ne
created shader.

To Modify the shader of an object:
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2 Click on the color swatch while hold-
ing the Ctrl-Key down.

3 The standard color picker should 
appear.

4 Select or enter the color you want and 
select OK.

5 Both the objects sharing this shader 
and the Shader Preview should change 
accordingly.

Texture maps using color images are 
extremely useful in the Color Channel.

If no texture is loaded, the texture 
swatch should display a light checker pat-
tern; otherwise you can see a preview of 
the loaded image.

RAYflect PhotoTracer lets you load 
either a JPEG or a BMP file

To use an image as Color Channel:
1 Select the Use Texture radio button.

2 If no texture was loaded a standard 
file selector is displayed, letting you 
choose the image file you want.
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Shader Channels
Each shader is made up of its channels 

defining the properties of the object 
material.

Shader Channels

Color Channel
No shader channel has a more obvious 

effect on the appearance of an object than 
the color channel.

As the color channel you can use either 
a plain color or an image which will be 
wrapped round the object: this image is 
called a Texture Map.

Color Channel

To specify a color as Color Channel:
1 Select the Use color radio button

2 Click on the color swatch.

3 A pop-up color window appears c
taining a color spectrum.

4 Release the mouse button when t
mouse cursor is on the color you 
want. The color swatch should dis
the selected color.

5 Both the objects sharing this shad
and the Shader Preview should cha
accordingly.

To numerically specify a color as Color Ch
nel:
1 Select the Use color radio button
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2 The texture swatch should show an 
image rotated.

3 Both the objects sharing this shader 
and the Shader Preview should change 
accordingly.

Rotate Icon

To perform a horizontal flip of the image:   
1 Click on the arrow icon in the bot-

tom left corner of the texture swatch.

2 The texture swatch should show a 
flipped image.

3 Both the objects sharing this shader 
and the Shader Preview should change 
accordingly.

Vertical Flip Icon

To perform a vertical flip of the image:   
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and the Shader Preview should change 
accordingly.

To change the texture used as Color Channel
1 Click on the little disk icon.

or
1 Activate the local menu (right mouse 

button click on Windows/ Com-
mand-Click on Macintosh) and 
choose Load.

2 A standard file selector should appear, 
letting you choose the image file you 
want to load.

3 Once the file is loaded the texture 
swatch should display a preview of 
your image.

4 Both the objects sharing this shader 
and the Shader Preview should change 
accordingly.

Disk Icon

To clear a previously loaded texture:
1 Click on the cross icon.

or
1 Activate the local menu (right mo

button click on Windows/ Com-
mand-Click on Macintosh) and 
choose Clear.

2 Both the objects sharing this shad
and the Shader Preview should cha
accordingly.

Cross Icon

RAYflect PhotoTracer allows you to
modify the position of the texture ma
on the objects.

You can rotate, flip and even tile th
original image.

To perform a 90 degree rotation of the im
1 Click on the rotate icon in the bo

tom right corner of the texture 
swatch.
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With RAYflect PhotoTracer you can 
simulate almost any highlights by setting 
the highlight color and the highlight size, 
called shininess.

A bright Highlight color will produce a 
bright highlight. The Shininess slider 
controls the size of the highlight. A high 
value will produce small highlights.

Real materials whose highlights are very 
bright have a high shininess value, unlike 
materials whose highlights are soft which 
have a low shininess value.

 

Highlight Channel

To change highlight color:
1 Click on the highlight color swatch.

2 A pop-up color window appears con-
taining a color spectrum.
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left corner of the texture swatch.

2 The texture swatch should show a 
flipped image.

3 Both the objects sharing this shader 
and the Shader Preview should change 
accordingly.

Horizontal Flip Icon

To increase the tiling of the texture:
1 Click on the vertical + icon to 

increase the vertical tiling.
or

1 Click on the horizontal + icon to 
increase the horizontal tiling.

2 Both the objects sharing this shader 
an the Shader Preview should change 
accordingly.

Increase Tiling Icon

To decrease the tiling of the texture:
1 Click on the vertical - icon to 

decrease the vertical tiling.
or

1 Click on the horizontal - icon to 
decrease the horizontal tiling.

2 Both the objects sharing this shad
and the Shader Preview should cha
accordingly 

Decrease Tiling Icon

Highlight Channel
In the real world objects show high

lights when they are illuminated. The
bright spots are reflections of light 
sources onto the material.

Plastic surfaces show dimmed and l
highlights, unlike metallic objects wh
highlights are small and bright; other
materials like stone or concrete do no
produce highlights.
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adjacent pixels. This means that if your 
image is filled with a plain color, it will 
not produce any bumping. As color infor-
mation in the image is not used by RAY-
flect PhotoTracer (what is important is 
the relative changes between adjacent 
pixels) it is often better to use grayscale 
pictures as bump maps.

Bump Channel

If no bump map is loaded, the bump 
map swatch should display a light checker 
pattern; otherwise you can see a preview 
of your image.

RAYflect PhotoTracer lets you load 
either a JPEG or BMP file.

To change the texture used as Bump Channel
1 Click on the little disk icon.

or
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mouse cursor is on the color you 
want. The color swatch should display 
the selected color.

4 Both the objects sharing this shader 
and the Shader Preview should change 
accordingly.

To numerically specify highlight color
1 Click on the color swatch while hold-

ing the Ctrl-Key down.

2 The standard color picker should 
appear.

3 Select or enter the color you want and 
hit the OK button.

4 Both the objects sharing this shader 
and the Shader Preview should change 
accordingly.

To change the shininess
1 Drag the thumb of the shininess 

slider.

2 Both the objects sharing this shader 
and the Shader Preview should change 
accordingly.

Rough surfaces are extremely diffic
to model and lead to complex object
Imagine the irregularities of an orang
skin: it would be impossible to geom
cally model each irregularity by hand

RAYflect PhotoTracer simulates the
variations on the surface of an object
really efficient way with the Bump Ch
nel.

By placing a picture in the Bump C
nel you can disturb a smooth surface 
add irregularities.

Note: Bump Channel does not modify 
surface of the geometric objects but rat
changes the angle of incidence of the lig
at certain points of the surface thus pro
ing a ’bumpy’ effect. As this is a trick o
RAYflect PhotoTracer the edges of the 
objects remain smooth.

To simulate bumps the texture used
the Bump Channel (also called bump
map) must specify a variation betwee
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To perform a horizontal flip of the image:   
1 Click on the arrow icon in the bot-

tom left corner of the texture swatch.

2 The texture swatch should show a 
flipped image.

3 Both the objects sharing this shader 
and the Shader Preview should change 
accordingly.

Vertical Flip Icon

To perform a vertical flip of the image:   
1 Click on the arrow icon in the upper 

left corner of the texture swatch.

2 The texture swatch should show a 
flipped image.

3 Both the objects sharing this shader 
and the Shader Preview should change 
accordingly.
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button click on Windows/ Com-
mand-Click on Macintosh) and 
choose Load.

2 A standard file selector should appear, 
letting you choose the image file you 
want to load.

3 Once the file is loaded the texture 
swatch should display a preview of 
your image.

4 Both the objects sharing this shader 
and the Shader Preview should change 
accordingly.

Disk Icon

To clear a previously loaded texture:
1 Click on the cross icon.

or
1 Activate the local menu (right mouse 

button click on Windows/ Com-
mand-Click on Macintosh) and 
choose Clear.

and the Shader Preview should cha
accordingly.

Cross Icon

RAYflect PhotoTracer allows you to
modify the position of the texture ma
on the objects.

You can rotate, flip and even tile th
original image.

To perform a 90 degree rotation of the im
1 Click on the rotate icon in the bo

tom right corner of the texture 
swatch.

2 The texture swatch should show a
image rotated.

3 Both the objects sharing this shad
and the Shader Preview should cha
accordingly.

Rotate Icon
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Reflection Channel
Many real materials are reflective, for 

instance glass or metallic materials.
RAYflect PhotoTracer allows you to set 

the color of the reflection, letting you 
create both subtler and more fantastic 
effects.

Usually a highly reflective object 
appears more vivid when its reflection 
color is a variation of the object’s color. 
RAYflect PhotoTracer lets you specify a 
completely different color in the reflec-
tion than in the color channel, leading to 
unusual effects.

Darker colors used in the reflection 
channel produce less reflection (black 
means no reflection), unlike brighter col-
ors which produce more.

Reflection Channel
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To increase the tiling of the texture:
1 Click on the vertical + icon to 

increase the vertical tiling.
or

1 Click on the horizontal + icon to 
increase the horizontal tiling.

2 Both the objects sharing this shader 
an the Shader Preview should change 
accordingly.

Increase Tiling Icon

To decrease the tiling of the texture:
1 Click on the vertical - icon to 

decrease the vertical tiling.
or

1 Click on the horizontal - icon to 
decrease the horizontal tiling.

2 Both the objects sharing this shader 
and the Shader Preview should change 
accordingly 

Decrease Tiling Icon

In order to achieve subtle effects wh
modifying a surface, RAYflect Pho-
toTracer provides you with a slider to
change the intensity of the Bump effe

This slider, whose range is -3 to +3,
you increase the bump effect (high va
ues), soften the bump effect (low valu
and even inverse the bump effect (ne
tive values).

To change the bump intensity:
1 Drag the thumb of the bump inten

slider.

2 Both the objects sharing this shad
and the Shader Preview should cha
accordingly.

Bump Intensity Slider
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4 Both the objects sharing this shader 
and the Shader Preview should change 
accordingly.

To numerically specify transparency color
1 Click on the color swatch while hold-

ing the Ctrl-Key down.

2 The standard color picker should 
appear.

3 Select or enter the color you want and 
hit the OK button.

4 Both the objects sharing this shader 
and the Shader Preview should change 
accordingly.

Usually when light rays pass through a 
semi-transparent object, their trajectories 
are deflected. This well-known behavior 
is called refraction. Glass, water and other 
materials refract light, leading to a dis-
torted view of objects behind the refrac-
tive surface. The factor which controls 
the amount of distortion is known as the 
index of refraction.

RAYflect PhotoTracer lets you change 
the index of refraction of the shader 
RAYflect PhotoTracer™ User Manual ©1998 RAYflect SA

To change reflection color:
1 Click on the color swatch.

2 A pop-up color window appears con-
taining a color spectrum.

3 Release the mouse button when the 
mouse cursor is on the color you 
want. The color swatch should display 
the selected color.

4 Both the objects sharing this shader 
and the Shader Preview should change 
accordingly.

To numerically specify reflection color
1 Click on the color swatch while hold-

ing the Ctrl-Key down.

2 The standard color picker should 
appear.

3 Select or enter the color you want and 
hit the OK button.

4 Both the objects sharing this shader 
and the Shader Preview should change 
accordingly.

This channel controls the transpare
of an object.

In RAYflect PhotoTracer, you can s
the transparency color. The brighter 
transparency color, the more you can
through the object.

To achieve realistic transparent obje
it seems better to use a similar color b
in the Color and Transparency chann

 Transparency Channel

To change transparency color:
1 Click on the color swatch.

2 A pop-up color window appears c
taining a color spectrum.

3 Release the mouse button when t
mouse cursor is on the color you 
want. The color swatch should dis
the selected color.
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3 A rendered image of your scene with 
the final quality should appear

Interactive Texture Tab

Assigning textures to objects
The first thing to do is to select the 

object you want to texture.

To select an object to texture:
1 Click on the object you want to tex-

ture in the image.

The Shader Editor will then show the 
current shader associated with the 
selected object.

Modifying any channel will modify the 
rendered image, automatically and in 
real-time.

It becomes really simple to change the 
color or the texture of an object, and 
even its bump map or its reflection color.
RAYflect PhotoTracer™ User Manual ©1998 RAYflect SA

slider.

To change the index of refraction:
1 Drag the thumb of the refraction 

index slider

2 Both the objects using this shader and 
the Shader Preview should change 
accordingly 

Index of Refraction Slider

To help you find good values, here is a 
little summary for various kinds of materi-
als:
• Air 1.0
• Water 1.3
• Alcohol 1.36
• Quartz 1.46
• Glass 1.5
• Diamond 2.46

 Interactive Texture Rende
RAYflect has introduced a new and

really powerful feature in RAYflect Ph
toTracer, letting you texture your sce
directly on the final rendered image.

The Interactive Texture Renderer is
useful to set-up:
• Textures on objects
• Lighting schemes
• Environments

How does it work?
The Interactive Texture Renderer r

ders the current scene with the final q
ity, storing some useful information 
needed to perform the shading.

The Interactive Texture Renderer is
extremely simple to use.

To activate the Interactive Texture Rende
1 Simply click on the Tab labeled 

'Interactive Texture'

2 Click on the black image in the ce
of window
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toTracer is really general, reflection and 
refraction are also taken into account.

So RAYflect PhotoTracer is able to 
change the textures of reflected objects.

Modifying lighting scheme
RAYflect PhotoTracer is able to take 

into account any modification you make 
to the lighting scheme (see next chapter) 
and refresh the preview of the final ren-
dered image accordingly and in real-time.

Modifying the Environment
RAYflect PhotoTracer is able to take 

into account any modification you make 
to the environment (see next chapter) 
and refresh the preview of the final ren-
dered image accordingly and in real-time.

Limitations
To perform all these tasks, RAYflect 

PhotoTracer needs to store several pieces 

consumption.
Moreover, RAYflect PhotoTracer, in

order to achieve fast image refresh, u
slightly different reflection and refrac
settings than its normal renderer. Thi
means that while you are editing the 
tures in the Interactive Texture Rende
the reflection and refraction levels (se
next chapter) are fixed to some good 
not too high) values.
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every direction. Just imagine that it is the 
equivalent of daylight in the real-world. 

Ambient Light

To set Ambient Light color:
1 Click on the color swatch.

2 A pop-up color window appears con-
taining a color spectrum.

3 Release the mouse button when the 
mouse cursor is on the color you 
want. The color swatch should display 
the selected color.

To numerically specify Ambient Light color
1 Click on the color swatch while hold-

ing the Ctrl-Key down.

2 The standard color picker should 
appear.

3 Select or enter the color you want and 
hit the OK button.
RAYflect PhotoTracer™ User Manual ©1998 RAYflect SA

LIGHTING

The appearance of objects in RAYflect 
PhotoTracer is determined by the lights.

A good lighting scheme (lights’ posi-
tions and colors) can dramatically increase 
the readability and the atmosphere of a 
rendered scene.

The same scene rendered with two dif-
ferent lighting schemes will produce 
completely different results. For instance 
a lighting scheme whose lights are dark 
will produce a black image. Inversely a 
lighting scheme with bright lights will 
wash out subtle effects.

Lighting effects become visible in the 
Working Window when RAYflect Pho-
toTracer is configured on Flat shaded 
preview and above.

When you render your scene (by click-
ing on the Render Tool or by hitting the 
OK button), RAYflect PhotoTracer will 
use the current lighting scheme.

up to six infinite directional light sour
and one ambient light.

Infinite directional light sources are
outside the RAYflect PhotoTracer 3D
Workspace (thus their emitting points
not visible), and cast parallel light ray
the 3D Workspace. 

Light Sources Palette

 Ambient Li
Ambient light is uniform through t

3D workspace. It has no origin and n
predominant direction, since it radiate
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source will not contribute to the scene’s 
lighting.

To Change the color of a light source:
1 Click on the Light Color Swatch.

2 A pop-up color window appears con-
taining a color spectrum.

3 Release the mouse button when the 
mouse cursor is on the color you 
want.

Light Color Swatch

To numerically specify Ambient Light color
1 Click on the color swatch while hold-

ing the Ctrl-Key down.

2 The standard color picker should 
appear.

3 Select or enter the color you want and 
hit the OK button.
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Light set-up
RAYflect PhotoTracer lets you set up or 

modify each one of the six light sources.
For each light source, you can modify 

its color, its position in the 3D Work-
space, and its state.

Light source State
Each light source can be switched on or 

off (i.e. enabled or disabled). A switched 
off light source has no effect on the light-
ing of the scene.

To turn off a light source:
1 Make sure the light you want to 

switch off is actually enabled.

2 Click on the Bulb Light Icon.

3 The icon should change to a switched 
off bulb light.

4 The lighting of the scene viewed in 
the Working Window should be 
updated accordingly.

Bulb Light Icon OFF

To turn on a light source:
1 Make sure the light you want to 

switch on is actually disabled.

2 Click on the bulb light icon.

3 The icon should change to a switc
on bulb light.

4 The lighting of the scene viewed i
the Working Window should be 
updated accordingly.

Bulb Light Icon OFF

Light Source Color
Each one of the six light sources po

sesses its own color.
Darker colored light sources will ca

less light than brighter ones. This me
that if your light color is black, this li
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Light Source Position
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To change the side of the light:
1 Click on the icon showing an arrow.

2 The lighting of the scene viewed in 
the Working Window should be 
updated accordingly.

Light Side Icon
RAYflect PhotoTracer™ User Manual ©1998 RAYflect SA

The Light Source Position can be mod-
ified through the use of a virtual light 
sphere. 

To set the position of the light, imagine 
the light sphere as a glass ball surround-
ing your scene. The highlight shows 
where the light shines through the glass, 
towards the center of your scene.

As you can only see one hemisphere of 
the virtual light sphere at a time, there is a 
special control which is used to inverse 
the light position.

By default when this control shows an 
arrow from top to bottom, the light 
source is above the scene, and when the 
arrow is in the opposite direction, the 
light source is under the scene.

As there are six light sources and only 
one virtual light sphere, each light has a 
selector item graphically represented as a 
yellow dot. If the yellow dot is under the 
fourth light source for instance, this 
means that the light sphere will actually 
show the position of the fourth light.

To select the light source to be edited:
1 Click on the light source selecto

under the light source color swatc

2 The light source selected has a yel
spot as light source selector.

Light Source Selector

To set the position of a light:
1 Drag the highlight on the surface

the light sphere to position the li
source.

2 The lighting of the scene viewed i
the Working Window should be 
updated accordingly.

Light Sphere
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gradient, simulating a sky and a fake 
ground.

RAYflect PhotoTracer lets you load 
either a JPEG or BMP file.

To change the Environment Map
1 Click on the little disk icon.

or
1 Activate the local menu (right mouse 

button click on Windows/ Com-
mand-Click on Macintosh) and 
choose Load.

2 A standard file selector should appear, 
letting you choose the image file you 
want to load.

3 Once the file is loaded the texture 
swatch should display a preview of 
your image.

4 Once the file is loaded, the Environ-
ment map swatch should display a 
preview of your picture.

Disk Icon
RAYflect PhotoTracer™ User Manual ©1998 RAYflect SA

RENDERING

When you have built a scene, set lights 
and chosen a viewpoint, you are ready for 
rendering.

The rendering operation is the process 
of calculating the final image.

RAYflect PhotoTracer uses a really fast 
but accurate rendering engine, based on a 
hybrid Scanline-Raytracer renderer.

The renderer used by RAYflect Pho-
toTracer performs a very good anti-alias-
ing. Your scene will never show jagged 
edges.

Environment Map
The Environment is a great way to 

improve objects’ reflections.
Imagine that the Environment map is 

projected on the inside of a big sphere 
surrounding your scene. Any reflective 
objects will reflect this map.

The environment is really useful when 
your scene contains highly reflective 

objects). Rendering reflective objects
without a good Environment map w
give dull effects on objects (since the
nothing to reflect). Chrome and met
effects are best achieved with a good 
Environment map, for instance a land
scape image.

Environment Map

RAYflect PhotoTracer lets you selec
image as your Environment, and lets 
rotate, flip and tile it.

If no Environment map is loaded, t
Environment map swatch should disp
a light checker pattern; otherwise you
see a preview of your image.

If there is no Environment map load
a default environment is used: it is a b



Rendering
Environment Map

59

:
t-

tch.

 

per 

 

To increase the tiling of the image:
1 Click on the vertical + icon to 

increase the vertical tiling.
or

1 Click on the horizontal + icon to 
increase the horizontal tiling.

Increase Tiling Icon

To decrease the tiling of the texture:
1 Click on the vertical - icon to 

decrease the vertical tiling.
or

1 Click on the horizontal - icon to 
decrease the horizontal tiling.

Decrease Tiling Icon

Note: the Environment effect can only be 
seen in rendering mode (this means either 
RAYflect PhotoTracer™ User Manual ©1998 RAYflect SA

To clear a previously loaded Environment 
map:
1 Click on the cross icon.

or
1 Activate the local menu (right mouse 

button click on Windows/ Com-
mand-Click on Macintosh) and 
choose Clear.

Cross Icon

RAYflect PhotoTracer allows you to 
modify the position of the texture maps 
on the objects.

You can rotate, flip and even tile the 
original image.

To perform a 90 degree rotation of the image:
1 Click on the rotate icon in the bot-

tom right corner of the texture 
swatch.

2 The texture swatch should show an 
image rotated.

Rotate Icon

To perform a horizontal flip of the image
1 Click on the arrow icon in the bo

tom left corner of the texture swa

2 The texture swatch should show a
flipped image.

Vertical Flip Icon

To perform a vertical flip of the image:
1 Click on the arrow icon in the up

left corner of the texture swatch.

2 The texture swatch should show a
flipped image.

Horizontal Flip Icon
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To enable or disable the computation of 
Reflection:
1 Simply click on the Reflection toggle 

button.

2 The result will be visible in the final 
rendered image.

Reflection Toggle

To enable or disable the computation of 
Refractions:
1 Simply click on the Refraction toggle 

button.

2 The result will be visible in the final 
rendered image.

Refraction Toggle

To change the amount of reflections com-
puted:
RAYflect PhotoTracer™ User Manual ©1998 RAYflect SA

the final rendered image).

Renderer Settings
RAYflect PhotoTracer allows you to 

customize the render pass.
You can decide whether to render 

reflections and refractions or not.
Rendering reflections will be slower 

(provided that there are some reflective 
objects in the scene) than rendering with 
no reflections, and rendering refractions 
will be slower (provided that there are 
some transparent objects with refraction 
in the scene).

The refraction toggle button lets you 
indicate to the renderer that it should be 
aware of the index of refraction of each 
object.

RAYflect PhotoTracer allows you to set 
up the number of reflections and trans-

the render pass.

Warning: High reflection and transpa
ency levels produce slower render than 
values.

When the Reflections are disabled, 
reflection level slider is automatically r
to zero, and when Reflections are 
enabled, the slider is set to the last re
tion level value. This means that if th
Reflection toggle is unchecked, reflec
objects will only reflect the Environm
map.

Reflections and transparency are co
puted by spawning new rays reflected
transmitted) by surfaces. Reflection L
(and transparency level) control the 
amount of newly spawned rays for on
pixel of the rendered image. Thus the
greater the level, the greater the time
needed to compute new rays and colo
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1 Simply drag the thumb of the Reflec-
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Rendering time depends on the com-
plexity of your scene (number of objects, 
complexity of objects), the amount of 
reflective or transparent objects, and the 
size of the image.

RAYflect PhotoTracer renders the final 
image in the Adobe Photoshop docu-
ment, so the final image size and resolu-
tion is fixed by the size and resolution of 
the Adobe Photoshop document or selec-
tion.

RAYflect PhotoTracer can only render 
to true RGB documents. If you need 
another kind of document, simply render 
to a RGB document and use Adobe Pho-
toshop functions to convert the image to 
another type of color model.

RAYflect PhotoTracer lets you render in 
any layer. So it can be used to create a 
composition where the RAYflect Pho-
toTracer scene is in one layer and a back-
ground image is in another one. You can 
then move the scene rendered in Adobe 
Photoshop and place it precisely over the 
RAYflect PhotoTracer™ User Manual ©1998 RAYflect SA

tion Level slider to the desired 
amount.

Reflection Level

Warning: High reflection level produce 
slower render than low values.

Be aware that in the Interactive Texture 
Renderer, the amount is fixed at 1.

To change the amount of transparency com-
puted:
1 Simply drag the thumb of the Trans-

parency Level slider to the desired 
amount.

Refraction Level

Warning: High refraction level produc
slower render than low values.

Be aware that in the Interactive Tex
Renderer, the amount is fixed at 4.

Rendering a sce
Once your scene is built and your v

point is chosen to match the view you
want, you can now render your final 
image.

To Generate the final image:
1 Simply click on the OK button.

2 Rendering should begin automati
cally.

OK and Cancel buttons
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background. Anti-aliasing will be perfect, 
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since RAYflect PhotoTracer integrates a 
powerful anti-aliasing engine.
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http://www.winzip.com/
or PKZIP(R) by PKWare, Inc. 
http://www.pkware.com/
Both products are available in tryout/

evaluation versions. 

Warning: Some unzipers do not create by 
default the sub folders. Use the option: "Use 
Folder Names".

When properly unzipped, you should 
have an "Objects" folder containing the 
following sub folders:

- Characters
- Fruits
- Fun
- Miscellaneous
- Packaging
- Primitives
- Web
RAYflect PhotoTracer™ User Manual ©1998 RAYflect SA

OBJECT CATALOGUE

Introduction
Thank you for purchasing RAYflect 

PhotoTracer.

RAYflect PhotoTracer includes more 
than 230 objects. Because they were cre-
ated for RAYflect PhotoTracer, shading 
can be fully edited.

This objects has been created especially 
for RAYflect PhotoTracer by expert 3D 
Modelers at RAYflect: you can be assured 
of their quality.

The objects are organized by theme:
• Characters
• Fruits
• Fun
• Miscellaneous
• Packaging
• Primitives
• Web

index of the rendered objects by cate
gory.

To use the objects simply run Photo
shop and launch RAYflect PhotoTrac
then open the file. See RAYflect Pho-
toTracer User Manual for more infor
tion.

Installat

Windows 95 / 98 / Windows NT
First download the archive on the R

flect Web site.

To install RAYflect PhotoTracer:
1 Unzip the archive

2 Copy the “Objects” folder where 
want on you hard disk.

After downloading a ".zip" file in W
dows, use WinZip(R) by Nico Mak C
puting:

http://www.winzip.com
http://www.pkware.com
http://www.pkware.com
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MacOS
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First download the archive on the RAY-
flect Web site.

To install RAYflect PhotoTracer:
1 Unstuff the archive

2 Copy the “Objects” folder where you 
want on you hard disk.

Getting Technical Support
For Technical Support or for more 

information about RAYflect's products, 
see our World Wide Web site on the 
internet:

http://www.rayflect.com

http://www.rayflect.com
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/Objects/Primitives/
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(i) permit other individuals to use the 
Software except under the terms listed 
above;

(ii) modify, adapt, translate, reverse 
engineer, decompile, disassemble or cre-
ate derivative works based upon the Soft-
ware;

(iii) copy the Software (except for back-
up purposes);

(iv) sell, resell, rent, lease, sublicense, 
assign, or otherwise transfer rights to the 
Software; or

(v) remove any proprietary notices or 
labels on the Software.

3. Copyright
The structure, organization and code of 

the Software are valuable trade secrets of 
RAYflect S.A. licensed to you on a non-
exclusive basis.

This license is not a sale. All title and 
copyrights in and to the Software, as well 
as any backup copy made by you, are 
owned by RAYflect S.A. and may be pro-
tected by applicable copyright or other 
RAYflect PhotoTracer™ User Manual ©1998 RAYflect SA

END-USER LICENSE 
AGREEMENT

Important notice
By downloading the Software, opening 

the media package, installing the Soft-
ware on your computer, or by entering a 
registration number to activate it, you 
agree to be bound by all the terms and 
conditions of this agreement. If you do 
not agree with these terms, you must 
promptly destroy all copies of the Soft-
ware and accompanying documentation.

1. Definition
In this agreement, “Software” shall 

mean the machine readable Software pro-
gram. The term “Software” shall also 
include any upgrades, modified versions, 

Software licensed to you by RAYflect

2. Grant of lice
RAYflect S.A. grants you a non-exc

sive and non-transferable license to u
one (1) copy of the executable code o
the Software and accompanying mate
als according to the following terms:

You may:
(i) use the Software on any single c

puter residing in your premises;
(ii) use the Software on a second co

puter so long as the first and second c
puters are not used simultaneously; o

(iii) copy the Software for back-up 
poses provided any copy must contai
of the original Software's proprietary
notices and provided your backup cop
not installed or used on any compute

You may not:
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6. Governing law
This Agreement will be governed by the 

laws of France, held by the Tribunal de 
Grande Instance of the city of Paris, 
excluding the application of its conflicts 
of law rules. If any provision of this agree-
ment is held to be unenforceable, the 
remainder of this agreement shall con-
tinue in full force and effect.

In case this agreement is written in vari-
ous languages, only the French version 
will serve as proof.

7. Termination
This license shall terminate automati-

cally if you fail to comply with the limita-
tions described in this Agreement. No 
notice shall be required from RAYflect 
S.A. to effectuate such termination. On 
termination you must destroy all copies 
of the Software.
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Except as stated above, this agreement 
does not grant you any rights to patents, 
trade secrets, trademarks, copyrights or 
any other rights in respect of the Soft-
ware.

4. Product maintenance
RAYflect S.A. is not obligated to pro-

vide you with maintenance or updates for 
the Software. However, any maintenance 
or updates provided by RAYflect S.A. 
shall be covered by this agreement.

5. Disclaimer of warranty
THE SOFTWARE AND DOCUMEN-

TATION ARE PROVIDED AS IS 
WITHOUT WARRANTY OF ANY 
KIND. RAYFLECT S.A. FURTHER 
DISCLAIMS ALL WARRANTIES, 
INCLUDING WITHOUT LIMITA-
TION ANY IMPLIED WARRANTIES 
OF MERCHANTABILITY, FITNESS 
FOR A PARTICULAR PURPOSE, 

ENTIRE RISK ARISING OUT OF 
THE USE OR PERFORMANCE O
THE SOFTWARE AND DOCUME
TATION REMAINS WITH YOU. I
NO EVENT SHALL RAYFLECT S.
OR ITS SUPPLIERS BE LIABLE FO
ANY CONSEQUENTIAL, INCIDE
TAL, DIRECT, INDIRECT, SPECI
PUNITIVE, OR OTHER DAMAGE
WHATSOEVER (INCLUDING, 
WITHOUT LIMITATION, DAMAG
FOR LOSS OF BUSINESS PROFIT
BUSINESS INTERRUPTION, LOS
OF BUSINESS INFORMATION, O
OTHER PECUNIARY LOSS) ARIS
ING OUT OF THIS AGREEMENT
THE USE OF OR INABILITY TO U
THE PRODUCT, EVEN IF RAY-
FLECT S.A. OR A SALES AGENT H
BEEN ADVISED OF THE POSSIB
ITY OF SUCH DAMAGES. IN NO
EVENT SHALL RAYFLECT S.A. B
LIABLE FOR ANY DAMAGES IN 
EXCESS OF THE AMOUNT RAY-
FLECT S.A. RECEIVED FROM YO
FOR A LICENSE TO THE SOFT-
WARE.
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Vous êtes autorisé à:
• utiliser le Logiciel sur un (1) ordina-

teur situé dans vos locaux;
• utiliser le Logiciel sur un deuxième 

ordinateur tant que le premier et le 
second ordinateurs ne sont pas utilisés 
en même temps; et

• effectuer une copie du Logiciel à 
usage de sauvegarde, étant entendu 
que toute copie du Logiciel doit con-
tenir l’ensemble des documents 
l’accompagnant, et que la copie de 
sauvegarde ne soit ni installée ni util-
isée sur un ordinateur.

Vous n’êtes pas autorisé à:
• laisser un tiers utiliser le Logiciel, 

excepté en accords avec les conditions 
exposées ci-dessus;

• modifier, adapter, traduire, rétrocon-
cevoir, décompiler, désassembler ou 
créer des produits dérivés basés sur le 
Logiciel;

• effectuer une copie du Logiciel 
(excepté à usage de sauvegarde);
RAYflect PhotoTracer™ User Manual ©1998 RAYflect SA

8. Entire agreement
This Agreement constitutes the com-

plete and exclusive agreement between 
RAYflect S.A. and you with respect to the 
subject matter hereof and supersedes all 
prior oral or written understandings, 
communications or agreements not spe-
cifically incorporated herein. This Agree-
ment may not be modified except in a 
writing duly signed by an authorized rep-
resentative of RAYflect S.A. and you.

LICENCE D’UTILISATION DE 
LOGICIEL

Important
Le fait de télé-charger le Logiciel, 

d’ouvrir son emballage, d’installer le 
Logiciel sur votre ordinateur, ou d’entrer 
un numéro d’enregistrement pour 
l’activer, vous lie à l’ensemble des termes 

n’acceptez pas l’ensemble de ces term
vous devez détruire immédiatement t
exemplaire du Logiciel ainsi que la do
mentation qui l’accompagne.

1. Définit
Dans le présent contrat, le terme 

“Logiciel” définit le programme Log
lisible sur ordinateur. Le terme 
“Logiciel” inclut également toutes 
amélioration, version modifiée, mise 
jour, addition, et copie du Logiciel d
la société RAYflect S.A. vous accorde
licence.

2. lice
La société RAYflect S.A. vous conse

droit d’usage non exclusif et non cess
du Logiciel, vous autorisant à utiliser
(1) exemplaire du Logiciel et de la do
mentation l’accompagnant, dans les c
ditions ci-après développées:
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MENT ET D’ADAPTABILITÉ A 
QUELQUE APPLICATION PARTI-
CULIERE QUE CE SOIT, SANS QUE 
CELA SOIT LIMITATIF. L'INTE-
GRALITÉ DES RISQUES 
INHÉRENTS A L'UTILISATION ET 
AUX PERFORMANCES DU 
LOGICIEL ET DE LA DOCUMENTA-
TION VOUS INCOMBENT ENTIER-
EMENT. EN AUCUN CAS LA 
SOCIÉTÉ RAYFLECT OU SES DIS-
TRIBUTEURS NE POURRONT ETRE 
TENUS POUR RESPONSABLES DE 
QUELQUES DOMMAGES QUE CE 
SOIT, CONSÉQUENTS OU SECON-
DAIRES, PARTICULIERS OU 
LOURDS, DIRECTS OU INDIRECTS 
(Y COMPRIS, ET SANS LIMITA-
TIONS, LES DOMMAGES CAUSES 
PAR LA PERTE DE PROFIT, LE 
MANQUE A GAGNER, LA PERTE DE 
DONNÉES, OU TOUTE AUTRE 
PERTE FINANCIERE) RÉSULTANT 
DE CE CONTRAT ET DE L'UTILISA-
TION OU DE L'INHABILITÉ A UTI-
LISER LE LOGICIEL. CETTE 
LIMITATION S'APPLIQUERA MEME 
SI LA SOCIÉTÉ RAYFLECT S.A. OU 
L'UN DE SES AGENTS COMMER-
RAYflect PhotoTracer™ User Manual ©1998 RAYflect SA

cession-bail, sous-licencier, attribuer, 
et de façon générale transférer vos 
droits sur le Logiciel; et

• enlever les étiquettes et les mentions 
de propriété du Logiciel.

3. Propriété intellectuelle
La structure, l’organisation et le code 

du Logiciel sont des secrets de fabrication 
ayant valeur pécuniaire appartenant à la 
société RAYflect S.A. qui vous sont licen-
ciés de façon non exclusive.

Cette licence d’utilisation n’est pas une 
vente. L’ensemble des titres et des copy-
rights du Logiciel et des éléments qui 
l’accompagnent, ainsi que toute copie à 
usage de sauvegarde effectuée par vos 
soins, restent la propriété de la société 
RAYflect S.A., et peuvent faire l’objet de 
protections en conformité avec les lois et 
les traités sur le copyright et la propriété 
intellectuelle. A l’exception des droits 
mentionnés ci-dessus, cette licence ne 

les secrets de fabrication, les marques
copyrights ni aucun droits relatifs au 
Logiciel et à sa documentation.

4. Maintena
La société RAYflect S.A. ne s’engag

aucun cas à vous fournir une maintena
ou des mises à jour du Logiciel. Tout
fois, toute maintenance ou  mise à jo
éventuellement fournies par la société
RAYflect S.A. devra respecter les con
tions du présent contrat.

5. Exclusion de garan
LE LOGICIEL AINSI QUE LA D

UMENTATION SONT FOURNIS 
"TELS QUELS" SANS GARANTIE
D'AUCUNE SORTE. LA SOCIÉTÉ
RAYFLECT S.A. EXCLUT ÉGALE-
MENT TOUTE GARANTIE, 
EXPRESSE OU IMPLICITE, ET N
AMMENT TOUTE GARANTIE 
IMPLICITE DE FONCTIONNE-
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RAYflect, the RAYflect logo, Ghost 
Menu and RAYflect PhotoTracer are 
trademarks of RAYflect S.A. , 9, rue 
Duphot, 75001 Paris, France. All other 
trademarks or registered trademarks are 
properties of their respective holders.
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L'ÉVENTUALITÉ DE TELS DOM-
MAGES. EN AUCUN CAS LA 
SOCIÉTÉ RAYFLECT NE POURRAIT 
ETRE TENUE POUR RESPONSABLE 
DE QUELQUES DOMMAGES QUE 
CE SOIT DONT LE MONTANT 
DEPASSERAIT LA SOMME RECUE 
PAR ELLE EN PAIEMENT DE LA 
LICENCE DU LOGICIEL.

6. Droit applicable
Le présent contrat est soumis au droit 

français, à l’exclusion de toute autre légis-
lation. Tout litige relatif au présent con-
trat sera soumis au Tribunal de Grande 
Instance de Paris. La nullité ou l’innapli-
cabilité de l’une quelconque des stipula-
tions du présent contrat n’emportera pas 
nullité des autres stipulations qui conserv-
eront toute leur force et leur portée.

En cas de rédaction du présent contrat 
en plusieurs langues, seule la version 
française fera foi.

7. Résiliat
En cas de non-respect par vous de v

obligations au titre du présent contra
celui-ci sera résilié automatiquement.
est expressément entendu que cette r
ation aura lieu de plein droit, sans som
mation de la part de la société RAYfle
ni exécution de formalités. En cas de 
résiliation, vous devrez détruire toute
copies du Logiciel en votre possession

8. Intégralité, modificat
Ce contrat représente l’intégralité d

engagements existant entre la société
RAYflect S.A. et vous. Il remplace et 
annule tout engagement oral ou écrit
toute communication ou accord 
antérieurs relatifs au présent contrat. 
présent contrat ne pourra être modifi
que par voie d’avenant dûment signé
chacune des deux parties.
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